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Основні поняття

Офсетний друк – найбільш поширений на даний момент спосіб друку великих тиражів. Відрізняється низькою кінцевою собівартістю та доброю швидкістю при достатніх тиражах. 

Етапи створення публікацій:

1. народження задуму поліграфічної продукції;

2. розробка загальної ідеї дизайну;

3. підбір ілюстрацій;

4. верстка матеріалу;

5. виведення створеної публікації в postscript файл;

6. перенесення цього файлу на фотоформи (плівки).

Друкарська форма – поверхня пластини, плити або формового циліндра, виготовлених з різних матеріалів (світлочутливого шару, фотополімеру, металу, пластмаси, паперу, дерева, літографського каменю), яка служить для створення і збереження зображення у вигляді окремих ділянок, які сприймають друкарську фарбу (друкарські елементи) і що не сприймають фарбу (пробільні елементи). 

Офсетна пластина – прямокутний алюмінієвий лист, покритий фоточутливим шаром. 

Друкарські елементи – утворюють зображення на друкарській формі, сприймають фарбу і передають її на папір або на проміжну ланку (офсетне полотно), створюючи в процесі друкування кольорове зображення на відтиску. 

Пробільні елементи – служать фоном для зображення на друкарській формі та не сприймають фарбу. Чим чіткіша межа між друкарськими та пробільними елементами, тим якісніша друкарська форма. 

Вартість тиражу – кількість якісних відтисків, яку можна отримати в процесі друкування до моменту розмивання меж між пробільними та друкарськими елементами.

Фотоформа в поліграфії – одноколірний негатив зображення, підготовлений для виготовлення друкарської форми. До них відносяться зображення, виготовлені на прозорих матеріалах, із застосування непрозорих фарб (креслення тушшю на прозорій плівці, діапозитиви, надруковані лазерним принтером на прозорій плівці та ін.). 

За виглядом зображення фотоформи поділяються:

1. негативні;

2. позитивні.

За полярністю зображення:

1. прямі;

2. дзеркальні.

Зображення для виготовлення друкарських форм офсетного друку повинно бути дзеркальним на фотоформі по відношенню до оригіналу.

Для виведення готового макету на плівки використовують фотонабірний автомат (ФНА) або спеціальний лазерний принтер. Для отримання кольорового відтиснення всі кольори, що становлять зображення друкуються по черзі при використанні одноколірної машини. Друк здійснюється в декілька прогонів. При використанні багатоколірних машин друк проводиться в один прогін, але в обох випадках використовується синтез кольорів за допомогою тріадних фарб: блакитна, пурпурна, жовта і чорна. ФНА виводить зображення різних кольорів на плівки з точністю розташування до мікрон та з високою роздільною здатністю. У разі прямого виводу на форми, стадія плівки пропускається. При технології прямого друку растрові дані (зображення) передаються безпосередньо на друкарську машину.

Переваги ФНА

1. ФНА дешевше за системи прямого експонування аналогічного формату;

2. технологічний процес на базі плівки гнучкіший і дає можливість компонувати форми будь-якого формату;

3. застосування ФНА допускає традиційний виробничий процес. Добре налагоджений і знайомий тим, хто займається до друкарською підготовкою, тому не вимагає спеціального перенавчання.

Основні вимоги до ФНА:

1. формат – повинен перекривати запечатувану область мінімум на 5-10 мм;

2. допуск – при однаковому допуску фотоформи, отриманій на різних ФНА, дають друкарську продукцію різної якості. Вважається, що точність поєднання повинна бути не нижче за одну четверту величини растрової крапки;

3. повторюваність – визначає точність поєднання фотоформ;

4. розмір і густина растрової крапки – повинна мати рівномірну оптичну щільність всередині, і чіткі краї;

5. якість алгоритму растрування.

Коли плівки готові, їх передають в друкарню, де зображення з них переносять на друкарські форми. При просвічування через плівку ультрафіолетовим світлом, фото чутливий шар пластини змінює властивості. В результаті, на пластині залишається чіткий відбиток зображення з плівки. Пластини установлюють в друкарські машини. 
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Основні види друку

До основних видів друку відносяться:

1. високий друк

2. флексографія

3. плоский (офсетний) друк

4. глибокий друк

5. трафаретний

Розрізняться вони розташуванням друкарський і пробільних елементів на друкарській формі.

Високий друк

Передбачає передачу тексту і зображень на запечатуваний матеріал з друкарської форми, на якій друкарські елементи розташовані вище за пробільні елементи. Друкарська фарба наноситься на поверхню виступаючих друкарських елементів і при зіткненні з папером переходить на нього. Для повного переходу фарби потрібен тиск. Для цього використовують прес. Різновидом високого друку є ксилографія, в якій друкарська форма виготовлялась з деревини. 

Переваги високого друку:

1. простота друкарського процесу

2. легкість у виготовленні друкарської форми  

3. чіткі контури зображень та букв

4. стабільність якості у всьому тиражі.

Флексографія

З’явився на початку 20 ст. раніше називався аніліновий друк. В технології друку застосовуються гнучкі полімерні форми. В основу закладено високий друк. Використовують рідкі фарби, в’язкість яких близька до в’язкості води. Флексографські машини розроблялись для друку на пакувальних матеріалах. Висока швидкість друкування на будь-яких рулонних матеріалах, дешеві друкарські форми, можливість одночасно на одній машині друкувати, лакувати, проводити тиснення і висікання дозволили використовувати флексографію для створення етикеток, шпалер та різного роду упаковок. А також, друкування газет, журналів, рекламної продукції та книг.

Недоліки флексоргафії:

1. великий розтиск растрової крапки;

2. проблеми з друком шрифтів маленького кегля;

3. погане відтворення тіней і світла;

4. неекономічність при маленьких тиражах.

Переваги:

1. відсутність обмежень на тип паперу: друк на картоні, самоклеющихся матеріалах, металевій фользі та плівкових полімерних матеріалах, на тканинах;

2. друкарські форми, що використовуються у флексографії мають високу тиражостійкість;

3. використання рідкої водорозчинної фарби дозволяє виготовляти упаковки для харчових продуктів.

Плоский (офсетний) друк

Текст і зображення передаються на запечатуваний матеріал з друкарської форми, на якій друкарські і пробільні елементи розташовані практично в одній площині. Вони володіють виборчими властивостями сприйняття олієвмісної фарби і зволожуючого розчину. Плоский друк буває двох видів:

1. непрямий; 

2. прямий.

До плоского непрямого друку відноситься офсетний друк: фарба з друкарської форми передається на еластичний проміжний носій (гумово-тканинне офсетне полотно), а потім з проміжного носія на папір. Щоб на друкарській формі досягався ефект відштовхування фарби, використовують два методи засновані на різних видах взаємодії поверхні друкарської форми і фарби:

1. у традиційному офсеті друкарська форма покривається зволожуючим розчином тонким шаром. При цьому пробільні елементи сприймають воду і не сприймають фарбу. Плівка зволожуючого розчину перешкоджає передачі фарби. А друкарські елементи навпаки сприймають фарбу і відштовхують воду.

2. у сухому офсеті поверхня друкарської форми покрита силіконовим шаром, що забезпечує фарбовідштовхуючі властивості форми. Шляхом видалення силіконового шару відкривається поверхня друкарської форми, що сприймає фарбу, друкарські елементи. На пробільних елементах силікон залишається.

Офсетним друком виготовляють газети, журнали, альбоми з мистецтва, рекламну продукцію. Друкарські апарати у всіх машинах для офсетного друку складаються з 

1. формового циліндра, 

2. офсетного циліндра, що обтягнений гумо-тканинним полотном, 

3. друкарського циліндра, що несе папір

4. механізму тиску.

Схема офсету:

1. створення друкарської форми. З фотоформи зображення експонується на плоску пластину зі світлочутливим шаром, який піддається фотохімічній обробці. Друкарські елементи обробляються спеціальним покриттям, що утримує фарбу і відштовхує воду. Пробільні елементи навпаки;

2. змочування. Друкарська форма вмонтовується на циліндр, що обертається. На нього потупає змочуючий розчин. Змочується все, окрім друкарських елементів, оброблених водовідштовхувальним складом;

3. нанесення фарби. Фарбувальний валик наносить на форму фарбу на масляній основі на ділянки форми, оброблені водовідштовхуючим складом;

4. перенесення фарби. Офсетний циліндр з еластичним гумово-тканинним покриттям, на який переноситься фарба з друкарської форми, притискається до паперу. Гумово-тканинне покриття злегка деформується, що дозволяє рівномірно переносити зображення як на гладкий, так і на текстурований папір;

5. друк. Папір проходить між офсетним і друкарським циліндрами. Офсетний циліндр притискається до паперу і відтискає остаточне зображення.

До переваг офсетного друку відносять 

1. різноманітність в компоновці елементів в межах однієї смуги. 

2. можливість двостороннього багатобарвного друку в один прогін.

3. наявність високопродуктивного устаткування.

До прямого плоского друку відносяться:

1. фототипія;

2. літографія.

При яких фарба з друкарської форми одразу переноситься на папір. 

Фототипія – без растровий спосіб: на світлочутливий пігментний желатиновий шар, що знаходиться на скляній основі, експонують негатив і відразу проявляють. Утворюються області різного ступеня набухання желатину при контакті з водою. Друкарська форма зволожується, що приводить до різного ступеня сприйняття фарби її ділянками. Відтиснення цим способом можна порівняти з фотографією. Це є дорогий спосіб друку. Використовують при друці кольорових, чорно-білих фотографій, малюнків олівцями та аквареллю.

Літографія – друкарська форма створюється на плоскому літографському камені. Малюнок на форму наноситься спеціальною жирною фарбою за допомогою пера, пензлика або літографського олівця. Півтона досягаються за допомогою різної сили натиску або нанесенням додаткових олівцевих штрихів. Камінь зволожується, пробільні елементи через це не сприймають фарбу. Цей спосіб дорогий. Використовують для виготовлення авторських екземплярів.
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Глибокий друк

Друкарські елементи на друкарській формі по відношенню до пробільних елементів є заглибленими. Пробільні елементи розташовані в одній постійній площині. На всю друкарську форму наноситься фарба, яка з пробільних елементів знімається ракелем (сталева пластина у вигляді ножа). Фарба залишається тільки в заглибленнях (тобто в друкарських елементах). Друкарська форма, рельєф якої повністю відтворює градацію тонів, виготовляється на мідній поверхні формового циліндра. Півтони на відтисненні виходять за рахунок зміни товщини барвистого шару. Різна глибина друкарських елементів змінюється в залежності від насиченості світлотіней. Якість кольорових і півтонових зображень способом глибокого друку є дуже високою завдяки високій частоті растру. Штрихові зображення і текст навпаки виходять нерівними, з щербинами, а дрібний текст взагалі є погано читабельним. Якщо необхідно отримати дороге видання, використовують комбінований спосіб друкування: текст і штрихові зображення – високим друком, півтонові і кольорові зображення – глибоким друком.

Трафаретний друк

Зображення на запечатуваний матеріал проводиться з трафарету, яким є тонка сітка. Крізь центри друкарських елементів за допомогою ракеля (гумового) продавлюється друкарська фарба. Ділянки сітки, що відповідають пробільним елементам покривають непроникним для фарби складом. Трафаретний друк інакше називають шовкографія. Особливістю трафаретного друку є можливість отримання грубшого барвистого шару. Тому такий спосіб застосовують для друку продукції, стійкої до зовнішніх дій (дорожні знаки, зовнішня реклама, вивіски, розтяжки і т.д.). Сітка друкарської форми може облягати різні поверхні, тому способом трафаретного друку можна друкувати на поверхнях геометричної форми. 

Різографія відноситься до трафаретного ротаційного друку. Друкарські форми виготовляють пропалюванням лазера або електричного розряду мікро отворів у формовому матеріалі для утворення друкарських елементів. Фарба подається зсередини формового циліндра під тиском. Різограф може друкувати в декілька кольорів. Для цього необхідно подати на друк стільки оригіналів, скільки є кольорів у даній публікації. Різограф не допускає друк на глянцевому та крейдовому папері. Оскільки фарба на основі гліцерину, вживана в різографі, висихає тільки на тому папері, в який може вбиратися. 

Вибір технології друку від виду продукції

1. журнали з ілюстраціями, газети друкують способом офсетного плоского друку. Папір для журналів переважно вибирають крейдований;

2. повноколірна реклама виготовляється або на листових офсетних машинах малого формату, або методом трафаретного друку;

3. книги друкуються способом офсетного плоского друку (текст), і способом високого друку (ілюстрації).

Основні характеристики паперу

Папір для друку вибирає видавництво або друкарня за узгодженням із замовником. Від цього залежить якість публікації. Основні властивості паперу:

1. маса (грам на метр квадратний) – визначає зовнішній вигляд публікації і спосіб друку. Інакше цей параметр називають товщиною паперу;

2. щільність і пористість – відображають структуру паперу. Якщо папір без покриття, то при високій щільності і незначній пористості буде низька здатність паперу сприймати фарбу. При низькій щільності і високій пористості – вищі друкарські властивості паперу. Відповідно, процес друку стабільніший;

3. деформація при зволоженні – при зволоженні знижується цупкість паперу, що приводить до дефектів друку. Деформація при зволоженні – це параметр, що визначає здатність паперу поглинати воду при безпосередньому контакті з навколишнім повітрям. Для крейдованого паперу деформація при зволоженні не повинна перевищувати 3%. Друк на папері з підвищеною вологістю приводить до поганих відтиснень, але і понижений вміст вологості може викликати певні проблеми. Оптимальна вологість паперу 6-8%;

4. розривна довжина – вимірюється в метрах і характеризує папір на міцність. Цей показник характерний для рулонних паперів. Розривна довжина – довжина паперової стрічки, при якій вона мимоволі відірветься від утримувача. Для газетного паперу розривна довжина складає 3 тис. метрів;

5. білизна – властивість паперу відбивати падаюче на нього світло розсіяно і рівномірно по всій видимій частині спектру. Наприклад, біло-блакитний лист відбиває більше світла в синьо-фіолетовому діапазоні видимого спектру. Для людського ока біло-голубі тони виглядають яскравіше, ніж насправді. Жовтувато-білий папір краще відображає кольори, розташовані в червоно-оранжевому діапазоні. Такий папір підійде для друку зображень в теплих тонах. Нейтральний білий колір листа відображає всі кольори спектру однаково і забезпечує найточніше перенесення кольорів;

6. яскравість – характеризує кількість світла, відбитого від поверхні листа. Технічна асоціація паперової промисловості (TAPPI) ранжирує яскравість за шкалою від 0 до 100. Чим вищий показник, тим вищий контраст між зображенням і папером, тим вища інтенсивність кольору;

7. прозорість – показник розпізнавання тексту і зображень із зворотного боку сторінки. Ступінь прозорості перевіряється на просвіт або за допомогою денситометра. Значення прозорості повинно складати не менше 94%;

8. розтискування – непряма властивість паперу, яка також залежить від фарби і технології друку. При зіткненні з папером растрова крапка змінює форму і розмір, що спливає на перенесення кольорів. Крейдований папір вбирає фарбу у декілька разів слабкіше, ніж газетний. 

Загальні технічні характеристики для всіх видів паперу

1. оптична однорідність;

2. товщина;

3. поглинаюча здатність по відношенню до фарби;

4. гладкість паперу.

При виборі паперу необхідно врахувати ряд правил:

1. ціна готового видання;

2. термін використання видання;

3. спосіб використання видання;

4. серйозні ділові видання вимагають читабельності тексту, тому не потребують використання блискучого паперу, а для рекламних листівок для розповсюдження інформації розумніше використовувати дешеві сорти паперу;

5. повноколірні календарі друкують на матовому крейдованому папері, щоб з відстані не відблискували.
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Визначення якості публікацій

Оформлення публікації залежиться від її призначення, бюджету та актуальності. До показників якості відносять:

1. вигляд обкладинки;

2. стильні шрифти заголовків;

3. передача кольорів;

4. легкість сприйняття тексту;

5. добре оброблені і виразні зображення;

6. якість паперу.

Основні параметри якості кольорового друку

1. приведення (точність суміщення складових кольорів);

2. точність перенесення кольорів;

3. стабільність попередніх параметрів впродовж друку тиражу.

Респектабельний вигляд тиражу надають використання додаткових кольорів (золото і срібло). Застосування різних видів фактури, покриття лаком, плівками, висікання і тиснення. Ці задачі покладаються на дизайнера на етапі планування проекту. 

Вибір програм макетування

Коли макет розроблений, текст набраний і відредагований, зображення оброблені, необхідно вибрати програму макетування. Загально визнані програми:

1. Quark Xpress;

2. Adobe InDesign;

3. Adobe PageMaker.

Quark Xpress

Вперше вийшла на ринок в 1987 році. Запропонувала верстку, зручну і просту у користуванні, продуманий інтерфейс та могутній інструмент для роботи як з текстом, так і з ілюстраціями, можливість роботи з великими документами. 

Adobe InDesign

Дизайн подібний до системи Illustrator. Інтегрований в Photoshop. 

Adobe PageMaker

Заснований на позиціюванні елементів на сторінці вручну. До переваг відносяться повна русифікація, висока надійність, нескладний інтерфейс та наявність засобів спуску смуг. Недоліки: складність підгонки тексту, час на пошук необхідної міжрядкової відстані, складність прив’язки тексту до сітки, відсутність засобів створення кривих та розташуванню тексту по ним.

Макетування. Визначення вимог до макету

Макет – набір правил, згідно яких розташовуються елементи на сторінці. Це є основа верстки. Всі періодичні видання прагнуть мати власний стиль, що запам’ятовується і впізнається. Задачі макету:

1. упорядкування документу, зробити його легко читаним та зручним для сприйняття;

2. полегшення праці верстальника.

В процесі розробки макету необхідно врахувати:

1. загальна елементи публікації;

2. кількість рівнів заголовків;

3. розміщення тетсту на сторінка;

4. місце ілюстрацій.

Початком макетування є розробка декількох ескізів. Текст можна розміщати на сторінці з книжковою або альбомною орієнтацією. Ліве і праве поля повинні бути достатньо вузькими і мати однакову ширину.  Верхнє поле більше лівого і правого, а нижнє – ширше верхнього. Рекомендуються наступні значення:

1. для лівого і правого по 3 одиниці;

2. верхнє – 5 одиниць;

3. нижнє – 8 одиниць.

На стандартній сторінці площа, зайнята набором, має складати 70-75% від загальної площі сторінки.

Ілюстрації і текст

Основні види верстки тексту з ілюстраціями:

1. закритий з виходом в поле. Малюнок розміщується із заходом на поле.

2. відкритий «під обріз». Малюнок розміщується із заходом на поле так, що при обрізанні листа відсікається частина зображення.

3. зображення на полях. Використовується для зображень малого формату.

4. глуха верстка. У двох або трьохколонному макеті малюнок розміщується між колонками і стикається з текстом чотирма сторонами.

5. верстка, закрита у волан. Малюнок розміщений у середині тексту і стикається з ним трьома сторонами.

6. закрита верстка урозріз. Малюнок стикається з текстом двома сторонами.

7. відкрита верстка у розріз і волан. Малюнок розміщується вгорі або внизу кожної смуги і стикається з текстом однією або двома сторонами. 

До основних видів верстки тексту з ілюстраціями виділяють чотири групи:

1. відкрита верстка (зображення вгорі або внизу смуги);

2. закрита верстка (зображення всередині тексту і стикається з ним двома або трьома сторонами);

3. глуха верстка (зображення в багатоколонному тексті, стикається чотирма сторонами);

4. верстка зображень на полях.

Правила при роботі з текстом і ілюстраціями

1. навколо кожної ілюстрації повинно бути достатнього вільного простору;

2. ілюстрації повинні поєднуватись між собою і вписуватись в загальну колірну схему;

3. в багатоколонному тексті ілюстрація займає ціле число колонок;

4. не рекомендується в одній публікації застосовувати відкриту і закриту верстку одночасно. Слід дотримуватись єдності оформлення;

5. не можна розміщувати зображення одного формату у волан і у розріз;

6. розмір зображення з підписом повинен бути парним по висоті цілому числу рядків основного тексту;

7. якщо на зображення є посилання, то зображення повинне розміщуватись на одному розвороті з посиланням і по можливості після посилання;

8. якщо зображення велике, і його висота приблизно дорівнює висоті смуги, то рекомендується розміщувати зображення на окремому листі;

9. підпис повинен бути розміщений під зображенням.

Рекомендації до оформлення публікації

1. основною думкою має бути зручність сприйняття;

2. початком роботи є нарис проекту на папері;

3. структуруйте матеріал і встановіть пріоритети та зв’язки між елементами;

4. виберіть стиль оформлення публікації, що відповідає змісту і призначенню;

5. однакові елементи оформляйте однаково;

6. маленька відстань між колонками та рядками роблять сторінку темною;

7. заголовки повинні відрізнятись від тексту та бути короткими і чіткими;

8. кегель заголовку залежить від рівня заголовка і кегля тексту;

9. ілюстрації однаково обробляйте та поєднуйте по стилю і формі;

10. навколо ілюстрацій робіть достатньо вільного простору;

11. кількість ілюстрацій повинна підпорядковуватись принципу мінімальної достатності.

Наступна лекція – контрольна робота!!!

Бали за контрольну

Гаврилюк 24

Коваленко 24

Я 24

Януш 24
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Шрифти

Основні характеристики

Всі шрифти можна поділити на 4 групи:

1. шрифти із зарубками serif;

2. шрифти без зарубок sans serif;

3. декоративні decorative;

4. рукописні script.

Зарубки – поперечні елементи на кінцях штрихів букви (Т). 

У шрифтах без зарубок відсутні завершуючи елементи на кінцях штрихів. Таких шрифт називається рубаний (Т). 

Рукописні шрифти використовують для декоративних цілей. Клієнт заповнює бланк окремими буквами або фразами, зображення сканується, вводиться в комп’ютер і з використанням професійних шрифтових програм перетворюється в комп’ютерний шрифт.

Декоративний шрифт не входить в жодну з перерахованих груп і використовується, щоб виділити заголовок. 

Всі варіанти шрифтового зображення складають шрифтову гарнітуру. 

Класифікація шрифтової гарнітури:

Гарнітура

Зображення

Нахил і характер шрифта                        Щільність                                   Насиченість

Прямий                                                         вузький                                          світлий

Курсивний                                                    нормальний                                  напівжирний

Похилий                                                       широкий                                        жирний

Кожний шрифт характеризується розміром або кеглем.

Одиниці вимірювання

У поліграфічній промисловості діють три системи вимірювання:

1. метрична – застосовується для вимірювання лінійних величин (м, см), вагових величин (т, кг, г) і об’ємних величин (м3, л, см3);

2. друкарська – заснована на французькому дюймі. В 1737 році французький друкар Фурньє запропонував як основу одиницю вимірювання таку, що дорівнює 1/72 частині французького дюйму, і назвав цю одиницю друкарським пунктом. У 1880 році французький друкар Дідо ввів значення дюйма, що = 27,06 мм. Друкарська система (типометрія) вимірювання шрифтів використовується в набірному виробництві при підготовці текстових і образотворчих оригіналів до видання;

3. агло-американська – заснована на англійському дюймі, що = 25,4 мм => пункт = 0,3527 мм. Цей показник став стандартом для комп’ютерної промисловості.

Кегль, або розмір шрифту, визначається його висотою, що замірена в друкарських пунктах. Для замірювання використовується спеціальна типометрична лінійка з відмітками кеглів від 5 до 15.

Шпація – величина пропуску між словами при виключенні рядків в абзацних відступах, при виділенні тексту розрядкою та ін. Товщина шпації можлива він 1 до 20 пунктів, а кегель – від 6 до 20 пунктів.

Інтерліньяж – відстань між базовими лініями сусідніх рядків. За замовчуванням = 120% від кегля шрифту.

Виключення – вирівнювання рядка вліво, вправо або по центру. 

Кернінг – процес зміни відстані між окремими парами букв з невеликим кроком. Підвищує якість тексту.

Трекінг – відстань між буквами, що використовується для зміни щільності тексту. Чим більша розрядка між буквами, тим світліший текст.

Насиченість шрифту визначається відношенням товщини основного штриха до висоти рядкових букв. 

Формати шрифтів

Шрифти зберігаються у вигляді файлів та містять інформацію, яка запрошується додатками при відображенні документів на екрані або при друці на папері. Кожний шрифт містить 256 символів. До друкарської підготовки відносять три типи шрифтів:

1. Adobe Type 1 – створений в 1985 році фірмою Adobe System Int. Він повністю сумісний з мовою сторінок PostScript і підтримується всіма постскріпт пристроями. Знаки описуються за допомогою кривих Безьє. Шрифти Туре 1 складаються з кількох файлів:

a. Екранного шрифту .pfm

b. Шрифту принтера .pfb

2. True Type – створений фірмами Microsoft і Apple. Застосовує програмований метод розмітки. Для побудови знаків використовує квадратичні сплайни, які малюються на екрані швидше кривих Безьє. Шрифти поступаються за якістю аналогічним шрифтам в PostScript форматі. Складаються з одного файлу .ttf, який використовується і для виводу на екран і при друці на принтері. Перевагою є простота, більша поширеність та коштують дешевше.

3. Adobe Type 3.

Рекомендації з вибору шрифтів

1. шрифти із зарубками читаються легше, оскільки око «чіпляється» за зарубки. Застосовують до основного тексту, набраного стандартним розміром символів. Для великого або дуже маленького розміру символів застосовують шрифти без зарубок. Заголовок набирають рубаним шрифтом. 

2. текст, набраний прописними буквами, читається довше і сприймається гірше. 

3. напівжирний шрифт додає тексту виразності, а окремі слова краще виділяти курсивом. 

4. можливе виділення тексту зміною кольору шрифту.

5. небажано вибирати світлі тони для дрібного шрифту.

6. вибір шрифту залежить від характеру людини і статі. Чоловіки вибирають строгі шрифти, жінки – декоративні шрифти. Прямі шрифти характерні для обачливих людей, шрифти із зарубками – для людей, що прагнуть довіри і надійності. Шрифти без зарубок характерні для людей, що володіють розсудливістю і не прагнуть самовираження.

Основні вимоги до шрифтового дизайну

1. читабельність тексту залежить від підбору шрифту і колірного поєднання тексту і фону, які мають бути максимально контрастними. 

2. не застосовувати світлі тони до дрібного шрифту.

3. для великих об’ємів тексту застосовувати шрифти із зарубками по всій публікації.

4. для заголовків використовувати рубані шрифти.

5. вибраний шрифт повинен відповідати загальному стилю і спрямованості публікації.
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Параметри сторінок

Нормальні розміри пропуску між словами = 1 символ. У наборі не повинно бути коридорів, тобто поєднаних пропусків між словами по вертикалі в трьох і більше рядках. 

Абзацні відступи мають бути однаковими у всьому документі. Останній рядок абзацу має бути довший за абзацний відступ не менше ніж в півтора рази. Якщо набір виконується без абзацного відступу, то останній рядок має бути не повний. Довжина рядка = 60-65 символів, кількість рядків на сторінці = 30-40.

Якщо розділи починаються з нової сторінки, то остання сторінка розділу має бути заповнена не менше ніж на половину.

Правила перенесення

1. забороняється переносити абревіатури, що пишуться прописними буквами.

2. робити перенесення, що спотворюються сенс слова.

3. розривати перенесенням скорочення «т.п.», «т.д.».

4. розривати перенесенням цифри, що складають одне число.

5. якщо між цифрами є знак «–», то при перенесенні він залишається на попередньому рядку.

6. відокремлювати цифру з дужкою або крапкою від наступного слова.

7. ставити пропуск між знаком перенесення і частиною слова.

8. починати ряжок зі знаку перенесення.

9. переносити розділові знаки.

Не рекомендується:

1. відокремлювати ініціали від прізвища.

2. відокремлювати скорочені слова від імен і прізвищ.

3. відокремлювати цифри від скорочень і назв вимірювань.

4. ставити знак перенесення більш ніж в двох суміжних рядках.

Знаки і цифри

Не можна ставити пропуск між розділовими знаками і символом. 

Риски, що вживаються у верстці бувають трьох типів:

1. дефіс «-» вживається у складних словах та як знак перенесення, не відділяється пропусками;

2. тире «–» (Shift + Alt + «-») вживається між словами, виділяється пропуском, а між цифрами – ні. У прямій мові виділяється пропуском з правої сторони;

3. мінус (Alt + 0150) є коротшим за тире, пропусками не відокремлюється.

Не можна відокремлювати пропусками лапки від слів. Типи лапок:

1. «»

2. “”

Між знаком №, «знак параграфа» і цифрами обов’язково пропуск. Не ставиться пропуск між цифрою і %, сек., хв. і градусом (‘ “ °). Великі числа розділяються пропусками на групи по 3 символи.

Знаки «+» та «-» не відділяються від цифри. Дроби записуються без пропуску, для позначення десятих, сотих… використовуються кому. Слово після порядкового номера відділяється пропуском.

Комп’ютерна верстка

Це оформлення публікації, що включає шрифтове і колірне оформлення тексту та розміщення графічних елементів. План макетування сторінок:

1. налаштування програми на комфортний і швидкий режим роботи.

2. налаштування документу: формат, орієнтація сторінок, одиниць вимірювання, кількість сторінок, номер першої сторінки, дозвіл виведення публікації та драйвер пристрою виведення.

3. визначення кольорів (складових і плашечних).

4. розробка і створення стилів заголовків та основного тексту.

5. розробка і створення шаблонів для окремих сторінок.

6. верстка з урахуванням заданих параметрів.

7. підготовка файлів для сервісного бюро. Створення post_script і pdf файлів.

Команди PageMaker

1. File -> Properties -> Global – налаштування програми на конкретний режим роботи.

2. система вимірювання – всі одиниці вимірювання.

3. виділяти підсвічуванням – допомагає швидко виявити розріднені, густі та висячі рядки. Якщо прапорець задіяний – такі рядки сірого кольору.

4. перемикач зображення на екрані вказує спосіб відображення графіки на екран. Варіант «У вигляді плашок» підвищує швидкість роботи. Зображення промальовується у вигляді сірих прямокутників. Варіант «Стандартний» виводить зображення в низькій роздільчій здатності. «Висока роздільча здатність» показує варіант при друці.

5. перемикачі з групи «Параметри збереження» дозволяють вибрати спосіб збереження файлу. Вони діють на команду File -> Save.

6. кнопка «Додатково» відкриває діалогове вікно з додатковими установками:

a. перемикач TrueType – шрифти набувають форму символів та інтерліньяж.

b. редактор матеріалів – визначає шрифт, який не прив’язаний до верстки, а вибирається тільки для комфортності набору. Перехід з режиму верстки в режим редактора Редагування -> Текстовий режим.

c. в полі Графіка за допомогою перемикача «Стандарт для екранних версій» визначається режим відображення і збереження екранних версій імпортованих в публікацію. Параметр «Попереджати, якщо об’єм перевищено» визначає роботу з растровою графікою. За замовчуванням порогове значення об’єму = 256 КВ.

При виведенні публікації на друк потрібно вибрати варіант ppd файл.

26.11.2009

Налаштування документу

Після вибору команди File->New з’являється діалогове вікно документ Setup, в якому необхідно налаштувати наступні параметри:

1. в списку Page Size встановити остаточний розмір сторінки, враховуючи розташування міток обрізу, згинів та хрестів поєднання, при цьому враховувати розмір паперу (плівки), що буде використана;

2. за допомогою перемикача орієнтація визначається вертикальна (Tall) або горизонтальна (Wide) орієнтація сторінок;

3. поле Options визначає, як сторінки будуть відображатись на екрані. Прапорець Double Side встановлюється якщо публікація буде друкуватись з двох сторін листка;

4. прапорець Facing Pages (розворот) встановлюється при вибраному прапорці Double Side і дозволяє представити вигляд публікації з точки зору читача;

5. в полі Target Output Resolution вводить дозвіл (роздільча здатність) з яким буде надрукована остаточна версія публікації;

6. в полі Compose to Printer встановлюється драйвер потрібного пристрою виводу.

Визначення кольорів публікації

Всі кольори, що задіяні в публікації відображені в палітрі кольорів, яка з’являється після команд Window->Show Color. В палітрі кольорів завжди присутні чотири кольори:

1. None (без кольору) – робить замальований фрагмент прозорим;

2. Paper (папір) – призначає об’єкту колір паперу на якому буде друкувати об’єкт;

3. Black (чорний) – складовий чорний колір, що виводиться тільки на плівки і відповідає чорній фарбі;

4. Registration (суміщення) – чорний колір, але при діленні кольорів він буде присутнім на кожній з чотирьох плівок для відображення хрестів поєднання та іншої службової інформації.

Перед тим, як віддати публікацію на виведення видаліть всі зайві кольори (None!!!). Для цього застосовуємо команду Utilites->Define Colors->Remove Unused. 

Створення кольорів в публікації

PageMaker дозволяє створювати новий колір в будь-якій з трьох реалізованих в ньому колірній моделі. А саме:

1. RGB;

2. HLS;

3. CMYK.

Для цього виконуються наступні дії:

1. вибрати команду Window->Show Colors для відкриття палітри кольорів;

2. клацніть мишкою на значку, що відповідає за створення нового кольору в нижній частині палітри або вибрати команду Utilites->Define Colors та вибрати команду New. В обох випадках відкривається діалогове вікно Color Options;

3. ввести і’мя в поле Name. Задати тип кольору вибравши варіант Spot (плашечний) або Process (складовий). Визначити колірну модель та задати колірні координати;

a. прапорець Overprint (накладка) – визначає як буде друкуватись об’єкт з накладкою або з маскуванням;

b. в списку Type варіант Tint (відтінок) – задає відтінок будь-якого базового кольору.

Одноколірні зображення

Для чорно білих растрових зображень формату TIFF також можна змінювати колір через палітру кольорів. Тут можна визначити яскравість та контрастність через команди Element -> Image -> Image Control. 

Система управління кольорами CMS

Апаратно незалежна система управління кольором CMS призначена для забезпечення коректного перенесення кольорів на будь-яких пристроях, що працюють з кольором. Принцип дії CMS заснований на принципі роботи людського ока і працює в моделі lab, що не залежить від устаткування. Всі перетворення кольору між різними пристроями на всіх етапах створення публікації за допомогою профілів перераховуються з моделі CMYK в модель lab і зворотно. Ця функція вбудована практично у всіх графічних редакторах і програмах верстки. Виробники сканерів, принтерів, моніторів забезпечують свою апаратуру профілями в стандарті ICC і драйверами що сумісні із засобами системи управління кольором. CMS порівнює профілі зображення тих пристроїв, що беруть участь у додруковiй підготовці та при їх неспівпадінні включає механізм перетворення. Якщо ви обираєте колір на підставі того що бачите на моніторі, то необхідно включити CMS. Для цього при запуску PageMaker з компакту вибирається варіант Custom Install та вказується що встановлюється Kodac CMS. При натисненні кнопки Next з’явиться список профілів пристроїв. Необхідно вибрати профілі для сканера, принтера та для паперу.  

Треппінг

При кольоровому друці для кожного складового і плашечного кольору потрібна окрема друкарська форма, які виготовляють з негативних фотоформ по одному негативу для кожного кольору. Кольороподіл можна проводити в PageMaker. Потім виводити кольороподілені смуги на плівки або пластини. Якщо накласти плівки одна на одну, то можна побачити сторінку і чорно-білому варіанті. Поєднання кольороподілених форм називається приведенням. Привідні мітки (хрестики) наносять на чотирьох сторонах фотоформи за межами смуги. Якщо одна або декілька фарб будуть надруковані з певним зсувом, то між кольоровими елементами з’являться видимі зазори, a растрові крапки сприйматимуться як розрізнені елементи. В процесі друку на кожному етапі накопичуються погрішності через ряд об’єктивних причин:

1. деформація або зсув друкарської форми;

2. недостатня вогкість паперу;

3. деформація паперу та ін.

Для ліквідації цих погрішностей використовують треппінг – це умисне накладання однієї фарби на іншу тонкою смужкою уздовж межі їх зіткнення. Існує декілька способів задання треппінгу в публікації:

· за допомогою спец програм TrapWize, Trapezze, Island Trapper. Це є професійні програми на платформах Macintosh і Windows NT 2000. Вони виконують точний треппінг на основі автоматичних або ручних налаштувань. Програми достатньо дорогі;

· перед виводом постскріпт файлу на RIP (растровий процес фотоавтомату). Він переводить сторінку описану в термінах мови постскріпт у формат зрозумілий вивідному пристрою;

· вручну.
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Види треппінгу

1. якщо ви робите розширення (накладання), то тим самим поширюєте край об’єкту в навколишні кольори. Під час друку цей край друкується поверх фонової фарби, створюючи необхідне перекриття. Це є вид зовнішнього треппінгу;

2. якщо ви виконуєте стиснення, то поширюєте край тих кольорів, які оточують об’єкт. Під час друку фонова фарба друкується поверх фарби об’єкту. Це є внутрішній треппінг.

Відмінність напряму треппінгу полягає в напрямі розповсюдження.

Правила застосування треппінгу

1. якщо поєднують дві змішані фарби, то фарба, що друкується першою, розширяється або звужується під фарбу, що друкується другою.

2. якщо поєднуються колір, утворений тріадними фарбами та колір, створений змішаною фарбою, змішана фарба повинна друкуватися після тріадних фарб, а тріадні фарби розширюються (звужуються) під змішану.

3. у разі, коли поєднуються два кольори з близькою оптичною густиною, утворені тріадними фарбами, то треппінг розміщується під обома кольорами, комбінуючи зовнішній і внутрішній види, це є так званий центральний треппінг.

4. якщо поєднуються два кольори, утворені тріадними фарбами, порядок друку не має значення, а світліший з кольорів розширюється у бік темнішого. Таке перекриття менш помітне для ока.

Теппінг в середовищі PageMaker

Друк, при якому одна фарба наноситься поверх іншої називається друком з накладенням Overprint. При цьому змішування двох фарб призводить до появи нового кольору і кольори змінюються. Щоб уникнути цього, PageMaker автоматично маскує кольори, що перекриваються (Knockout). Вибрати друк об’єктів з накладанням або з маскуванням можна у діалоговому вікні Fill and Stroke, що викликається з меню Element. Перевагою PageMaker’a в цьому питанні є виконання треппінгу в тих місцях, де об’єкти перетинаються. Наприклад, той самий об’єкт може містити область зовнішнього треппінгу, там де він накладається на темний фон, область внутрішнього треппінгу там, де він накладається на світлий фон і область без треппінгу, де немає фону. Всі три області формуються автоматично. Недоліком PageMaker’y у питанні треппінгу є можливість вибрати параметри треппінгу тільки для всієї публікації та неможливість застосувати різні параметри для окремих об’єктів та комбінацій кольорів. Щоб переглянути та побудувати поточні значення треппінгу виконайте File -> Preference -> Trapping. 

Встановлення значень треппінгу

1. Trap Width – ширина смуги треппінгу – визначає ширину смуги треппінгу між двома суміжними кольорами, тобто ширину області перекриття для всіх кольорів, крім чорного. Окремо задається ширина треппінгу для кольорів, що знаходяться поряд з чорним або під ним. Це значення в 1,5-2 рази більше, ніж ширина треппінгу за замовчуванням.

2. Step Limit – чутливість – якщо кольори двох об’єктів, що перекриваються, близькі, тоді треппінг можна не виконувати. В полі чутливості задається значення наскільки близькими мають бути кольори, щоб треппінг не виконувався. Чим менше введене число, тим частіше відбуватиметься треппінг.

3. Centerline Threshold – треппінг по центральній лінії – якщо густина кольорів, що перекриваються, мало відрізняється один від одного, програмі важко вирішити, який з них є темнішим. Тому замість треппінгу паж макер назовні або всередину розташовує смугу треппінгу так, щоб її середина співпала з лінією зіткнення кольорів. Якщо в цьому полі набрати 70, то ви вкажете на необхідність треппінгу по центральній лінії, якщо густина світлого кольору складає не менше 70 відсотків від густини темного кольору. При значенні 0 всі області треппінгу за замовчуванням розміщуються по центральній лінії. При значенні 100 треппінг по центральній лінії буде відключено, внаслідок чого відбудеться повне розширення або стиснення. 

4. Trap text above – обробляти текст зверху – показник визначає наскільки високими повинні бути розміри шрифту, щоб не проводити треппінг. Значення за замовчуванням 23,9 pt означає, що PageMaker почне виконувати треппінг при висоті символів 24 та більше.

5. Traps Over Imported Objects – треппінг над імпортованими об’єктами – це значення дає вказівку застосувати одне повне значення треппінгу для того, що знаходиться внизу імпортованого зображення, якими б не були фарби компонентів.

6. Black Limit – поріг – задається процентний вміст чорної фарби в кольорі, який програма повинна вважати суцільним. За замовчуванням 100%. Якщо PageMaker зустрічає колір з процентним значенням чорного кольору, що відповідає встановленому у полі та вище то застосовується треппінг в полі для чорного.

7. Auto Overprint Black – авто накладення – включає 2 прапорця:

a. Text Below – текст до – друкуватиме із накладенням текст, кегель якого менше вказаного значення;

b. Stroke, Fills – лінія, фони – друкування чорних ліній і фону з накладенням.

8.
Ink Setup – відкриває діалогове вікно управління параметрами густини фарб. PageMaker звертається до них під час проведення треппінгу. Імпортовані граничні елементи автоматично друкуються з маскуванням, тому треппінг для них проводиться в середовищі, де вони були створені.

Контрольна

Я 22

Вітя 24

Діма 23

Мирослав 21

Андрій 19

17.12.2009

Створення стилів абзаців

Форматувати можна виділяючи фрагмент тексту або весь текст загалом та призначаючи йому відповідні параметри. Якщо текст великий та різноманітний то форматування займе достатньо часу та може призвести до значної кількості помилок. В цьому випадку можна скористатись засобами створення стилів абзаців. Це є певним чином оформлений список атрибутів для тексту в межах абзацу. Це є спосіб автоматизації форматування тексту. стилі, що задіяні в макеті містять вичерпну інформацію про шрифти і дозволяють передати документ в сервісне бюро без додаткового пошуку відомостей про шрифти. 

Стиль в пажмакері ж складовою частиною документу. Він копіюється разом із документом. Стилі можна копіювати в інший документ. 

Створення та редагування стилів виконується в діалоговому вікні Style Options, яке з’являється після команд Type -> Define Styles. Новий стиль обирається кнопкою New або командою New Style. Помістивши курсор в межах абзацу і вибравши інструмент Typi на палітрі стилів визначається певний тип стилю. 

Шаблони сторінок

Сторінки-шаблони дозволяють заощаджувати час та забезпечують єдиний стиль оформлення сторінок і цілих публікацій. Шаблони містять основні особливості публікації та можуть використовуватись при розробці аналогічних документів. Шаблони дозволяють забезпечити єдиний фірмовий стиль для всіх документів певної компанії. 

Застосування шаблонів зменшує розмір файлу публікації. Створені шаблони відображаються в палітрі шаблонів Master Pages. Параметри основного шаблону задаються при створенні документа у вікні Document Setup в меню Палітри шаблонів командою New Master Page. Після задання всіх параметрів шаблону та натисненні кнопки ОК, на екрані відкриється створена сторінка-шаблон, а її ім’я буде занесене в палітру шаблонів. 

Нумерація сторінок

Місце розташування номера сторінки визначається спеціальним символом, що називається маркером номера сторінки. Він вибирається комбінацією клавіш Ctrl+Alt+P. Маркер номера сторінки можна форматувати як звичайні символи. 

Створення змісту

Відбувається в кінці роботи над публікацією. Необхідно визначити, які заголовки будуть внесені в зміст. Ця робота буд пришвидшена, якщо форматування тексту відбувається з допомогою стилів абзаців. У діалоговому вікні Параметри абзацу (Paragraphs Specifications) стилів тих заголовків, що увійдуть в зміст необхідно встановити прапорець Include in Table of Contents. 

Після редагування стилів переходять до їх регенерації. Для цього вибирають команди Utilites -> Create TOC (створення змісту) та задають наступні параметри:

· Title (заголовок змісту)

· Format (задає правила розташування номера сторінки щодо елементів змісту)

· No Page Number (без номера сторінки – визначає що номер друкуватись не буде. Номер сторінки можна розташовувати перед або після елемента змісту)

Створення алфавітного покажчика

Створювати елементи покажчика можна в режимі верстки, але краще робити це в редакторі матеріалів, оскільки тільки в ньому можна побачити маркери входу покажчика (чорний прямокутник з білим ромбиком всередині). 

Для створення елемента покажчика виділяється слово або фрагмент тексту, який використовується як тема покажчика. Командами Utilites -> Index Entry з’являється діалогове вікно Add Index Entry. В групі Тип посилання (Typi) вибирається варіант Page Reference. Нижче розташовані три порожні поля, що відповідають трьом рівням посилань. Виділене раніше слово з’явиться в першому полі, це є тема першого рівня. Прапорці, що об’єднані заголовком Page Range (діапазон сторінок) визначають область дії посилання:

· Current page

· To next style change

· To next use of style

· For next <…> paragraphs

· Suppress page range

Після завершення введення елемента покажчика, перед виділеним словом з’явиться маркер покажчика, якщо ви знаходитесь в редакторі матеріалів. При формуванні алфавітного покажчика паж макер перевірить весь текст на наявність маркерів, зв’яже з ними відповідні слова або фрази та створить елементи покажчика.
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Спуск смуг

Створення багато сторінкової публікації передбачає послідовне розташування сторінок в порядку, необхідному для правильного друку і фальцювання. Таке перетворення називається створенням спускового макету або спуском смуг.

Порядок сторінок при монтажі друкованої форми 

Перевернуто 5 12 9 8

Нормально 4 13 16 1

Перевернуто 7 10 11 6

Нормально 2 15 14 3


Коли верстка публікації завершена, створені зміст і алфавітний покажчик, починається робота з доповненням Build Booklet (спуск смуг) Utilites -> Plug-ins -> Build Booklet. У вікні спуск смуг зі списку Layout вибирається варіант спускового макету:

· брошура 2-up saddle stitch

· книга 2-up perfect bound

· двосмуговий буклет 2-up consecutive

· трьосмуговий буклет 3-up consecutive

· чотирьох смуговий буклет 4-up consecutive

кнопка Blank Page служить для додавання до публікації порожніх сторінок, які неоюхідні для заповнення типографського розвороту. Invert Pages Змінити порядок сторінок. У полі Creep припуск можна задати величину, що компенсує ефект сповзання, який виникає при згині аркушів по середній лінії. Цей параметр необхідний для корекції розміщення смуг з урахуванням товщини паперу. У полі Gutter Space інтервал задається величина простору для підшивки. 

Підготовка публікації для передачі в сервісне бюро

Для виявлення проблем публікації і перевірки її на цілісність найзручнішим та найнадійнішим способом є застосування модуля Save for Service Provider (зберегти для сервісного бюро). Цей модуль аналізує публікацію, визначає відсутні шрифти, порушення звязку з файлами зображень, установки друку та параметри фарби. Utilites -> Plug-ins -> Save for Service Provider. 

Кнопка Preflight Pub запускає перевірку активної публікації.

Кнопка Preflight Ps запускає перевірку постскріпт файлу. 

Також є установки по вкладках:

· Fonts шрифти

· Links/OPI зв’язки

· Printing друк

· Inks кольори

При виборі перевірки активної публікації, необхідно в діалоговому вікні звернути увагу на дві кнопки: перша вказує на готовність шрифтів, друга – на готовність зв’язків. Готовність – зелені прапорці, неготовність – червоні хрестики. 

Створення postscript та PDF файлів

Мова постскріпт була створення в середині 80-х років фірмою Адобе як універсальна мова управління вивідними пристроями. Базою опису кривих в цій мові є криві Безьє.

Перед створенням постскріпт файлу перевіряються всі зв’язки, перевіряється зображення в моделі CMYK та перевіряється присутність в палітрі кольорів тільки необхідних для даної публікації кольорів. Проводиться перегляд сторінок публікації в масштабі «монтажний стіл». Публікація зберігається за командою Save As, що зменшує об’єм файлу.

Параметри друку

За командою File -> Print у діалоговому вікні Print Document задається тим принтера. Якщо вибраний постскріпт принтер, зявляється список PPD (PostScript Printer Description). 

В полі Copies можна задати кількість надрукованих копій, а прапорець Collate задає режим, коли копії публікації виводяться послідовно одна за одною. 

Прапорець Reverse змінює стандартну черговість друку сторінок публікації.

При створенні постскріпт файлу необхідно скинути прапорці Collate, Reverse, Proff (чернетка), Print Blank Pages (пусті сторінки).  

Параметри паперу

Перед тим як вивести публікацію на постскріпт принтер необхідно перевірити, чи поміщається вона на папері вибраного формату. У вікні Print Document кнопка Paper визначає параметр Format, який задає розмір паперу. Доступні варіанти визначаються обраним PPD файлом. При виборі формату потрібно врахувати, що це є до обрізний формат, який має включати мітки обрізу та хрести поєднання, які встановлюються прапорцем Printers Marks (типографські мітки). 

Прапорець Page Information (опис сторінки) встановлює на кожному листі папері та плівки ім’я файлу, номер сторінки, дату та назву складової або простої фарби. 

Збереження постскріпт файлу

У вікні Print Document кнопка Options визначає наступні установки:

1. Sent Image Date – оптимізувати графічні дані. Визначає параметри друку зображень:

a. Optimized subsampling (оптимізувати) – дозволяє надіслати на друк зображення з роздільною здатністю, що забезпечує достатню якість при заданій лініатурі.

b. Low resolution (низька роздільна здатність) – надсилає на друк зображення з екранною роздільною здатністю.

c. OmitImages (заборонити) – виводить замість зображення сірі прямокутники відповідного розміру.

d. Normal (нормальний) – виводить зображення з його власною роздільною здатністю. Використовується при створенні постскріпт файлу.

2. Data Encoding – кодування даних. Представляє два варіанти перекодування при виводі на друк:

a. Sent ASCII Image Data.

b. Sent Binary Image Data.

3. Download Fonts – завантажувати шрифти. Надає три варіанти:

a. PostScript and TrueType.

b. TrueType Only.

c. None.

Для подальшого запису постскріпт файлу необхідно встановити прапорець Write PostScript  to File та при необхідності змінити ім’я.

Кнопка Browse (каталог) вибирає папку для збереження файлу. 

Normal – стандартний файл. Надає розширення .ps та використовується для виводу на ФНА (фотонабірний автомат).

EPS – створює файл з розширенням .eps, використовується для включення в іншу публікацію в якості ілюстрації або для імпорту в іншу програму.

For Prepress – додрукова обробка. Створює кольоровий суміщений файл з розширенням .sep.

Save – запустить процес збереження.
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Створення PDF-файлу

Формат пдф має наступні переваги:

1. не накладає обмежень на зовнішній вигляд файлу. Для його перегляду потрібна безкоштовна програма Акробат Рідер.

2. не залежить від платформи.

3. зберігає форматування і колір, інформацію про шрифти, треппінг та ІСС профілі пристроїв.

Програма Adobe distiller конвертує файли з формату постскріпт у формат пдф.

Для утворення пдф файлу вибрати команду Файл – Експорт – меню Акробат ПДФ. На екрані відкривається діалогове вікно пдф оптіонс. Вкладка дженерал визначає загальні налаштування при створення пдф файлу. Розділ Паджес (сторінки) задає ту частину файлу, яку слід експортувати у формат пдф. Вкладка Гіперлінкс (гіперзвязки) керує перетворенням гіперзвязків. Щоб посилання зберегли своє призначення в пдф файлі, необхідно встановити прапорці: Інтернал Лінкс і Екстернал Лінкс.

Формат пдф передбачає можливість захисту документу. Захист має два рівні і включається по вкладці Секьюріті. Встановлюється два незалежних пароля. При введенні пароля Юзер Пасворд відбувається шифрування документу. Розшифровка проводиться в Акробат Рідер за вказаним паролем. Другий рівень захисту включається за паролем Мастер Пасворд. Він дозволяє в Акробат Рідер змінювати права доступу до файлу та можливість зміни самого пароля.

Після задання у всіх вкладках треба повернутись на вкладку Дженерал та натиснути кнопку Едіт Джоб Оптіонс (редагувати параметри завдання). Після встановлення всіх необхідних параметрів, провести експорт із заданням ім’я файлу пдф. Якщо виникли певні помилки, вони будуть відображені у створеному текстовому файлі.



